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1. INTRODUCTION 
 

A new Revit to FEM-Design Add-in that allows exporting a Revit analytical model into a struXML file 

has been developed. Main new features in comparison to the previous Add-In that was based on the 

.r2f file are: 

 Export of grid lines (as axes) and levels (as storeys). 

 Export of curved walls. 

 Export of eccentricity settings in case of floor slabs and walls. 

 Export of structural foundations. 

 New mapping dialog with the option to load FEM-Design Code sensitive libraries. 

 Better system of warning and error messages. 

2. INSTALLATION 

StruSoft StruXml Revit 2013 Add-In 1.0.001 Win32 (or Win64) and StruSoft StruXml Revit 2014 Add-In 

1.0.001 Win32 (or Win64) can be downloaded from the StruSoft download page:  

http://download.strusoft.com/FEM-Design/inst110x/ 

Run the installation file. After completion of the installation process, StruSoft FEM-Design panel will 

appear in the Analyze tab in Revit along with the Export StruXml command as shown in Figure 2-2. 

 
Figure 2-1 

 
Figure 2-2 
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3. EXPORTED ELEMENTS AND FEATURES 

Following elements and properties can be exported from Revit to FEM-Design using the struXML file 

based Add-In: 

Elements: 

- Structural Columns 

- Structural Framing elements (Beams, Beam systems, Braces, Trusses) 

- Structural Floors 

- Structural Walls 

- Structural Foundation1 

- Grids and levels 

Properties: 

- Material of en element 

- Section / Profile / Thickness of an element 

- Releases of linear elements 

- Boundary conditions 

- Eccentricity in case of floor slabs and walls 

The transfer of structural elements from Revit to FEM-Design is done by exporting an analytical 

model of an instance of an element along with its properties, i.e. material, section/profile/thickness, 

release conditions, eccentricity.  

 

If a structural element in Revit does not have analytical model enabled, it will not be 
exported to FEM-Design. 

3.1. STRUCTURAL COLUMNS AND FRAMING ELEMENTS 

Following properties of Structural Columns and Structural Framing elements are exported from Revit 

to FEM-Design along with the geometry of the Analytical Column or Analytical Beam element: 

- Section / profile  

- Material2 

- Eccentricity3 

- Release conditions 

3.2. STRUCTURAL FLOORS 

If one wants to export a Revit model containing floor elements, he needs to be aware that each 

structural floor element in Revit has to be a separate instance i.e. only one individual floor should be 

drawn using the Create Floor Boundary command as shown in Figure 3-1. If more than one floor 

element is created within one floor boundary (as shown in Figure 3-2), those elements will be 

exported as one floor instance that is equivalent into one plate element in FEM-Design. 

                                                           
1
 Structural Foundation is exported as boundary conditions. Find more information in Paragraph 3.4. 

2
 Only the Structural material is exported. Read more in Paragraph 3.5. 

3
 Read more about the rules of eccentricity export in Paragraph 3.6. 
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Figure 3-1 

 
Figure 3-2 

Following properties of Structural Floors are exported from Revit to FEM-Design along with the 

geometry of the Analytical Floor element: 

- Thickness of the structural layer 

- Material2 

- Eccentricity3 

3.3. STRUCTURAL WALLS 

Following properties of Structural Walls are exported from Revit to FEM-Design along with the 

geometry of the Analytical Wall element: 

- Thickness of the structural layer 

- Material2 

- Eccentricity3 

Curved walls can now be now exported from Revit to FEM-Design. Each curved wall drawn in Revit 

and exported to struXML file, in FEM-Design will be divided into a number of straight walls as show in 

Figure 3-3 (this is the way curved walls are handled in FEM-Design).  

 
Figure 3-3 
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3.4. STRUCTURAL FOUNDATIONS 

As for now Structural Foundations can be exported from Revit to FEM-Design as Supports according 

to the following manner: 

- Structural Foundation: Isolated in FEM-Design will be converted into Point Support Group with 

the default type: Hinged 

- Structural Foundation: Wall in FEM-Design will be converted into Line Support Group with the 

default type: Hinged 

- Structural Foundation: Slab in FEM-Design will be converted into a Surface support group. 

3.5. MATERIAL 

Each analytical element that is meant to be exported from Revit to FEM-Design needs to have a 

structural material assigned to its physical model. 

In case of multilayer walls or multilayer floor slabs, analytical model is exported along with the 

material (and thickness) property of a layer that is marked as a Structural Material. In the example 

shown in Figure 3-4, the wall element would be exported from Revit to FEM-Design as a 190 cm thick 

element with the material: Masonry – Concrete Block. 

 
Figure 3-4 

 

Element, which structural material is set to be <By Category>, will not be exported to FEM-
Design. An error about lack of structural material assigned to an element will appear after 
attempt to exporting such element.  
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3.6. ECCENTRICITY / ANALYTICAL ALIGNMENT 

In Revit user can decide about the position of Analytical Wall and Analytical Floor in relation to the 

physical model. Those settings are exported to FEM-Design as Eccentricity. 

 

Analytical Floor 

Following Analytical Alignment definition of an Analytical Floor is exported to FEM-Design: 

 

Alignment Method: Projection 

Projection: Top of Slab 

 Center of Slab 

 Bottom of Slab 

In any other case, i.e. Projection is set to a Level or a Reference Plane or the Alignment Method is set 

to be Auto detect, the default position of Analytical Floor in relation to physical element after export 

to FEM-Design will be: Center.  

 

Example of different settings in Revit and the final result after opening the exported model in FEM-

Design is shown in Table 3-1 and in Figure 3-5. 
 

 1 2 3 4 5 

Original Revit 

Alignment 

Method: 

Projection Projection Projection Projection Auto detect 

Projection: Top of Slab Center of Slab Bottom of Slab Level 1 - 

Exported  
FEM-Design 
alignment 

Top/Left Center Bottom/Right Center Center 

Table 3-1 

 

Figure 3-5 
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Analytical Wall 

Following Analytical Alignment settings of an Analytical Wall are exported to FEM-Design: 

 

Alignment Method: Projection 

Projection: Center of Element 

 Interior Face 

 Center of Core 

 Exterior Face 

In any other case, i.e. Projection is set to a Grid or a Reference Plane or the Alignment Method is set 

to be Auto detect, the default position of analytical model in relation to physical element after export 

to FEM-Design will be: Center.  

 

Example of different settings in Revit and the final result after opening the exported model in FEM-

Design is shown in Table 3-2 and in Figure 3-5. 

 

 1 2 3 4 5 

Original Revit 

Alignment 

Method: 

Projection Projection Projection Projection Auto detect 

Projection: 
Center of 

Element 
Interior Face Center of Core 

Exterior 

Face 
- 

Exported 
FEM-Design 
alignment 

Center Right Center Left Center 

Table 3-2 

 

Figure 3-6 
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3.7. RELEASES OF LINEAR ELEMENTS 

All linear analytical elements are exported from Revit to FEM-Design along with the settings of Top 

Release and Bottom Release. The exact definition of the three predefined releases: Pinned, Fixed, 

Bending Moment as well as User Defined release are exported to FEM-Design. Figure 3-7 shows 

release conditions originally set in Revit and the result of the export to FEM-Design. 

     
Figure 3-7 

3.8. BOUNDARY CONDITIONS 

In Revit, Boundary Conditions command allows to choose between three kinds of boundary 

conditions: Point, Line, and Area. User has to assign it with one of predefined or user defined State in 

X, Y and Z direction: Fixed, Pinned, Roller, and User.   

The exact definition of a boundary condition can be exported from Revit to FEM-Design as follows: 

Boundary Condition Type: 

 Point: exported to FEM-Design as Point Support Group 

 Line: exported to FEM-Design as Line Support Group 

 Area: exported to FEM-Design as Surface Support Group 

State: 

 Fixed: exported to FEM-Design as type Hinged 

 Pinned: exported to FEM-Design as type Rigid 

 Roller: exported to FEM-Design according to  Revit definition 

 User: exported to FEM-Design according to  Revit definition 
 

Example: Point boundary condition type with the Pinned state is exported to FEM-Design as Point 

Support Group, type: Hinged as shown in Figure 3-8. 

 
Figure 3-8 
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3.9. GRIDS 

Grids defined in Revit model may be exported to FEM-Design where they will be recognized as Axes. 

Grids are exported with following assumptions: 

 If the option to Export Grids is selected, always all the grids will be exported to FEM-Design. 

 The exact length of the each grid is exported. 

 All the grids are always exported into 00.000 m level in FEM-Design. 

 Names of the grids are not exported. Each axis in FEM-Design will receive a new number based 

on the order of grid creation in Revit, as shown in Figure 3-9. If necessary, renaming can be 

performed in FEM-Design.  

 
Figure 3-9 

 In FEM-Design only straight line axes are allowed. Therefore,  
 

 Multi-Segment Grid after export from Revit to FEM-Design will be replaced with a number of 

straight line axes equivalent to number of segment, 

 curved grid after export from Revit to FEM-Design will be replaced with a straight line axis 

between the start and end point of the original curved grid, as shown in Figure 3-10. 

 
Figure 3-10 
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3.10. LEVELS 

Levels defined in Revit model can be exported to FEM-Design, where they will be recognized as 

Storeys. 

Levels are exported with following assumptions: 

 If the option to Export Levels is selected, always all the levels will be exported to FEM-Design. 

 Name of the levels are exported to FEM-Design. 

 Size of the Storey in FEM-Design is calculated based on the placement of most outer elements in 

the Revit model and included as a Horizontal size of building in the Storey dialog, as shown in 

Figure 3-11. 

 
Figure 3-11 

 Levels cannot be exported if no elements are created in the Revit model because size of a storey 

cannot be generated. A warning shown in Figure 3-12 will appear in that case. 

 
Figure 3-12 
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4. EXPORT FROM REVIT TO FEM-DESIGN 

Before trying to export the model from Revit to FEM-Design, make sure that: 

 all the elements you wish to export have analytical model enabled,  

 the analytical model of the structure is consistent,  

 all the elements you wish to export have a structural material assigned.  

 

If the analytical model is prepared, proceed with the Export StruXML command that is placed in the 

StruSoft FEM-Design panel in the Analyze tab in Revit. 

 
Figure 4-1 

Upon choosing the Export StruXML command, a Code dialog shown in Figure 4-2 will appear. Before 

exporting model to FEM-Design, it is necessary to select one of the design codes. Chosen code and 

national annex will influence the material and sections library that will be used for mapping. After 

choosing the desired code standard, check Set as default box, if you want to save this choice. 

  
Figure 4-2 

Upon pressing OK in the Code dialog, a StruXML Export dialog will appear, as shown in Figure 4-3. 

 

Figure 4-3 
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4.1. EXPORT  

In the Export tab of a StruXML Export dialog user can:  

 change the previously chosen Code Standard, 

 decide if to export or not Grids and/or Levels, or not 

 see the list of warnings (orange bullets) and errors (red bullets), as well as export results listed in 

the status window, 

 export the model to struXML file. 

 
Figure 4-4 

Situation 1: After launching StruXML Export dialog there are no warnings about unmapped 

elements, as shown in Figure 4-4. 

It means that all the materials and profiles used in your current project have already been mapped 

and saved before, and no mapping is needed. However, it is recommended to go to Materials and 

Sections tabs in order to check and approve the previously saved mapping.  

In this situation, the procedure is as follow: 

1. In the Export tab, press an icon with three dots to define location and name of the struXML file.  

2. Press the Export button.  

When the export is finished, an export status will be displayed in the status window as shown in 

Figure 4-5. Information about the number of elements exported will be displayed along with the list 

of possible errors (red bullets).  

Go to Paragraph 4.4 in order to read about meaning of possible warnings and errors.  

3. Press Close button to close the dialog. 
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Figure 4-5 

Situation 2: After launching StruXML Export dialog there is a list of warnings about unmapped 

elements, as shown in Figure 4-6. 

It means that all or some of the materials and/or sections included in the Revit model have to be 

mapped to the corresponding materials/sections in FEM-Design.  

 
Figure 4-6 

In this situation, the procedure is as follow: 

1. Go to Materials tab and map the listed materials (read more about materials mapping in 

Paragraph 4.2). 

2. Go to Sections tab and map the listed sections and profiles (read more about sections mapping in 

Paragraph 4.3). 

3. Go back to Export tab, and if there is no warning left in the status window, follow the procedure 

from Situation 1 in order to export the model. 
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4.2. MATERIALS MAPPING 

In order to map the materials included in the Revit model one should move to Materials tab, shown 

Figure 4-7. The dialog is divided into two parts: Revit materials in the left part and FEM-Design 

materials in the right part.  

 
Figure 4-7 

Only current items 

You can decide if you want to see (and map) all the materials from the Revit model library or only 

those that are currently being used in the model. Only current items option is always checked by 

default. Uncheck it in order to see all the materials from in the Revit library. 

In the left window materials, based on their Revit category: Concrete, Metal, Wood, are sorted into 

following groups: Concrete, Steel, and Timber. Material of any other category than Concrete, Metal, 

and Wood will be sorted under group Unassigned.  

Mapping procedure 

1. Click on the small triangular next to the material category to open a drop down list of materials 

to be mapped within this category and select one of the materials. Any material that has to be 

mapped will be displayed in red. Any of material that have already been mapped before will be 

displayed in black.  

2. Find a corresponding material in the FEM-Design library in the right part of the dialog. Click on 

the small triangular next to the material category to open a drop down list of available materials 

from the FEM-Design library and select desired material. 

3. Press the Map selected item button. Material that has just been mapped turned black. 

4. In order to save the material mapping (and update the warning list in the status window in the 

Export tab) press Apply.  

Unmapping procedure 

5. If you wish to unmap any of the previously mapped materials, select the material in the Revit 

materials window and press the Unmap Selected Item button. 

6. If you wish to unmap all of the previously mapped materials, do not select any material – just 

press the Unmap All Mapped Items button. 
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Figure 4-8 

Load FEM-Design library 

If you added additional materials into FEM-Design materials library and you wish to perform mapping 

into those materials, you need to update the default FEM-Design library in the StruXML Export dialog 

to the desired one. The code of the new materials library imported from FEM-Design has to be 

consistent with the chosen Code Standard in the StruXML Export dialog. 

The procedure is as follows (shown in Figure 4-9 and Figure 4-10): 

1. In FEM-Design go to the Default settings of e.g. Colum. 

2. Go to Material tab. 

3. Press the Export… button. 

4. Chose Material library (*.struxml) in Save as type, find a location and name the library. 

5. Chose Save button. 

6. Go back to the Materials tab in the StruXML Export dialog and press Load FEM-Design library. 

Find and select the desired struXML file. 

7. Press Open button.  

 

Remember to always load the current FEM-Design library. This will prevent from mapping 

into a material that may not exist in the current library used in FEM-Design. 

Press Reset button in order to reset the materials library to the default one. 

Export / Import Mapping 

Once performed materials mapping can be saved to struXML file using Export Mapping button. Use 

Import Mapping button in order to load mapping from struXML file. 



 Structural Design Software in Europe AB | Copyright© 2013 StruSoft. All rights reserved. Page 17 

 

 

 
Figure 4-9 

 
Figure 4-10 
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4.3. SECTIONS MAPPING 

In order to map the sections one should move to Sections tab shown in Figure 4-11. The dialog is 

divided into two parts: Revit sections in the left part and FEM-Design sections in the right part.  

 

Figure 4-11 

Only current items 

At a start you can decide if you want to see (and map) all the sections from the Revit model library or 

only those that are currently being used in the model. Only current items option is always checked by 

default. Uncheck it in order to see all the sections and profiles from in the Revit library. 

In the left window Revit sections are listed without being grouped to any category. 

Mapping procedure 

1. Click on the small triangular next to the Sections to open a drop down list of sections to be 

mapped and select one item. Any section that has to be mapped will be displayed in red. Any of 

section that have already been mapped before will be displayed in black.  

2. Find a corresponding section in the FEM-Design library in the right part of the dialog. Click on the 

small triangular next to the section category to open a drop down list of available sections from 

the FEM-Design library and select a desired one. 

3. Press Map selected item button. A section that has just been mapped will turn black. 

4. In order to save the sections mapping (and update the warning list in the status window in the 

Export tab) press Apply.  

Unmapping procedure 

5. If you wish to unmap any of the previously mapped sections, select the section in the Revit 

sections window and press the Unmap Selected Item button. 

6. If you wish to unmap all of the previously mapped sections, do not select any section – just press 

the Unmap All Mapped Items button. 
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Figure 4-12 

Load FEM-Design library 

If you added additional sections into FEM-Design sections library and you wish to perform mapping 

into those sections, you need to update the default FEM-Design library to the desired one. The code 

of the new sections library imported from FEM-Design has to be consistent with the chosen Code 

Standard in the StruXML Export dialog. 

The procedure is as follows: 

1. In FEM-Design go to the Default settings of e.g. Colum. 

2. Go to Sections tab. 

3. Press the Export… button. 

4. Chose Sections library (*.struxml) in Save as type, find a location and name the library. 

5. Chose Save button. 

6. Go back to the Sections tab in the StruXML Export dialog and press Load FEM-Design library. Find 

and select the desired struXML file. 

7. Press Open button.  

 

Remember to always load the current FEM-Design library. This will prevent from mapping to 

a section that may not exist in the current library used in FEM-Design. 

Press Reset button in order to reset the materials library to the default one. 

Export / Import Mapping 

Once performed sections mapping can be saved to struXML file using Export Mapping button. Use 

Import Mapping button in order to load mapping from struXML file. 
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4.4. WARNINGS AND ERRORS 

Here is a list of all possible warning and error messages that can appear while using the Revit to FEM-

Design StruXML Add-In: 

Warning: Unmapped Material: “Name of the material from Revit” 

Explanation: This warning may appear in the status window after launching StruXML Export dialog. 
It only warns that there are some materials in the Revit model that have not been 
mapped yet. The warning will disappear after the material is mapped and the 
material mapping is confirmed with the Apply button. 

 

 
Figure 4-13 

Warning:  Unmapped Section: “Name of the section from Revit” 

Explanation: This warning may appear in the status window after launching StruXML Export dialog. 
It only warns that there are some sections in the Revit model that have not been 
mapped yet. The warning will disappear after the sections are mapped and the 
sections mapping is confirmed with the Apply button. 

 

 
Figure 4-14 



 Structural Design Software in Europe AB | Copyright© 2013 StruSoft. All rights reserved. Page 21 

 

 

Error:  The code standard of the file and application differ. 

Explanation: This error will appear if you try to Load FEM-Design library that has a different Code 
Standard than the chosen Code Standard in the StruXML Export. Both the code 
standards have to be consistent in order to perform a valid mapping. 

 

 
Figure 4-15 

Error:  There are no structural elements in the document, therefore levels cannot be 
exported. 

Explanation: This error will appear if you try to Export Levels but there are no elements in the Revit 
model. This is not possible as the size of the Storey in FEM-Design cannot be then 
calculated if there are no elements in the Revit model.  

 

 
Figure 4-16 
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Error:  Element: “Type” ”Number“ failed to export with issue: ‘Lack of analytical model‘ 

Explanation: This error will appear after an attempt to export a Revit model that includes an 
element that do not have analytical model enabled. Elements with no analytical 
model cannot be exported to FEM-Design. This will warn you about it and give you a 
chance to correct your model and repeat the export. 

 

In case there are some elements that should not be exported to FEM-Design and 
therefore, they do not have analytical model enabled (e.g. partition walls), this error 
can then be ignored. 

 

 
Figure 4-17 

Error: Element: “Type” ”Number“ failed to export with issue: ‘No structural material 
assigned to it‘ 

Explanation: This error will appear after an attempt to export a Revit model that includes an 
element that do not have a structural material assigned to it. If a structural material is 
set to be <By Category> it cannot be exported to FEM-Design. This will warn you 
about it and give you a chance to correct your model and repeat the export. 

 

This kind of error may appear only for elements that have analytical model enabled. 
In case there are elements in your Revit model that are not meant to be exported and 
therefore, do not have analytical model and structural material assigned, you will first 
receive information about lack of analytical model in those elements. 

 

 
Figure 4-18 
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Error: Element: “Type” ”Number“ failed to export with issue: ‘Material has not been 
mapped‘ 

Explanation: This error will appear if the warning about unmapped material has been ignored and 
the export was performed anyway. Element without mapped material cannot be 
exported to FEM-Design. 

 

 
Figure 4-19 

Error: Element: “Type” ”Number“ failed to export with issue: ‘Section has not been mapped‘ 

Explanation: This error will appear if the warning about unmapped section has been ignored and 
the export was performed anyway. Element without mapped material cannot be 
exported to FEM-Design. 

 

 
Figure 4-20 
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5. OPEN STRUXML IN FEM-DESIGN 

StruXML file containing exported model from Revit has to be open directly in FEM-Design. StruXML 

files can only be open in the 3D Structure module of FEM-Design 11 (starting from version 11.01.001) 

and FEM-Design 12.0. 

Procedure is as follows: 

1. Open FEM-Design 3D Structure. 

2. From the main menu choose: File  Open. 

3. Choose StruSoft common structure XML files (*.struxml) in the Files of type and browse for the 

desired file. 

4. Press Open button. 

 

Figure 5-1 
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6. UPDATE FEM-DESIGN MODEL 

A new command Update File has been introduced in FEM-Design. It is enabled in FEM-Design 11 

starting from version 11.01.003 and in FEM-Design 12. It is accessible from the main menu: Edit → 

Update File. 

The Update File command gives a possibility to update initially exported elements4 to FEM-Design 

with the following changes that have been made in Revit afterwards:  

 Material change 

 Section / Thickness change 

 Geometry change 

Changes in material/profile/thickness/geometry properties are detected in the file containing the 

updated model in relation to the elements that are exported to FEM-Design at the moment.  

 

After the initial model is imported to FEM-Design, it has to remain at the original coordinates 

exported from Revit. Otherwise, the update of the model with changes performed in Revit 

will not be successful.  

6.1. PROCEDURE  

The procedure to update a model in FEM-Design is as follows: 

1. Export the updated Revit model into new .struxml file (it cannot have the same name as the 

previously exported file). 

2. Open a FEM-Design project containing the model that has been originally imported from Revit. 

3. Go to Edit → Update File. 

4. Select the new .struxml file containing the updated model and press Open. 

6.2. LIMITATIONS 

The functionality of the Update File command at the current state of development has some 

limitations concerning elements that have been deleted in the updated Revit model or in FEM-

Design: 

 If an element has been deleted in the updated Revit model, after using the update command, 

this element will not be deleted from FEM-Design model. 

 If an element has been deleted in FEM-Design model (but not in updated Revit model) and then 

updated with other changes made in Revit, it will reappear in FEM-Design. 

6.3. EXAMPLE 

Here is a brief example showing functionality of the Update File command. 

                                                           
4
 Due to the fact that curved walls after export to FEM-Design are converted into number of straight walls, 

update of curved walls is not possible. 
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1. In the first step, model shown in Figure 6-1 has been exported from Revit to struxml file and 

opened in FEM-Design (Figure 6-2). 

 

Figure 6-1 

 
Figure 6-2 

2. In FEM-Design following actions have been performed: 
 

 Added support. 

 Added loads and load combinations. 

 Added bracing. 

 
Figure 6-3 
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3. Meanwhile some changes have been applied to Revit model, and the updated model has been 

exported to new .struxml file. Following changes have been applied to the initial Revit model: 
 

 First span is now shorter than initially - columns and one beam have been moved, and the 

other beams got shorter. 

 Additional span covered with concrete floor has been added. 

 Profile of the two columns supporting the concrete floor changed and they have been 

rotated 90 degrees in relation to the original position. 

 
Figure 6-4 

4. FEM-Design model (at the stage as shown in Figure 6-3) has been updated with the new .struxml 

file containing changes made in Revit since the first export. 

The effect of the update is shown in Figure 6-5. 

 The first span is now shorter. 

 Additional span and concrete floor has been added. 

 Two columns supporting the concrete floor changed their profile and direction/rotation. 

However, 

 the applied load will not adjust itself if the geometry changed - it has to be done manually 

(e.g. using Move or Stretch command). The load cases and load combinations remain in the 

FEM-Design model. 

 since the first span got shorter and two columns have been moved, the supports that have 

been applied in FEM-Design need to be adjusted to the new position of columns.  

 
Figure 6-5 
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5. The model has now been adjusted in FEM-Design and some additional area loads have been 

applied to the concrete floor. The effect is visible in Figure 6-6. 

 

Figure 6-6 

6. Meanwhile one more change has been applied in the Revit model - a hole was made in the 

concrete floor. The updated model was exported yet to another .struxml file. 

 
Figure 6-7 

7. FEM-Design model (at the stage as shown in Figure 6-6) has been updated with the newest 

.struxml file containing changes made in Revit since the previous export. 

The effect of the update is shown in Figure 6-8 – a hole has been added to the floor, nothing else 

has changed.  

 
Figure 6-8 


